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GENERAL 
The San Diego Union-Tribune strongly suggests using a professional 
page layout software for file creation. These include, but are not limited 
to, Quark XPress and Adobe InDesign. Such programs allow vector & raster 
elements to be used and recognized by other system, including RIPs and 
preflight software.

Creating files completely in raster applications such as Photoshop, may 
result in vector elements being downsampled by preflight processes.

The San Diego Union-Tribune does not have true bleed pages. The 
dimensions given will always be for the ‘live’ area (Double-truck pages do 
use ‘gutter’ space, so this is an exception to the rule).

Please contact your Sales Representative for the latest page dimensions.

DIGITAL FILE TRANSMISSION
AdDrop
AdDrop is a direct link to our file upload system. 
The URL is http://upload.sandiegouniontribune.com/addrop/ 

First time users, please contact your Sales Representative before your 
initial upload.

San Diego Union-Tribune MEDIA KIT
General sizes and Deadlines can be found @
www.sandiegouniontribune.com/sd-utads-htmlstory.html#print

PREFERRED FILE FORMAT
PDF’s are the preferred file format. An acceptable PDF job option setting 
is: PDF/X-1a:2001 with no Output Intent applied.

The PDFX/1a setting is a default ‘Job Option’ setting 
in Acrobat Distiller Professional 6.0 and above. This 
preset defaults to SWOP (Specification for Web Offset 
Publications), which has a TAC/TIL of 300%. This is NOT 
recommeded. You can download the SDUT Distiller 
Setting to the right with no Output Intent applied:

SPECIFICATIONS FOR NEWSPAPER ADVERTISING 
PRODUCTION (SNAP)

The San Diego Union-Tribune abides by the Specifications for Newspaper 
Advertising Production (SNAP).

These specifications are designed to improve the quality of newspaper 
reproduction.

These specifications are published by the Newspaper Association of 
America (NAA; www.naa.org).

The specification that would be of most interest to designers is the 
registration specification.

The Out-of-Registration tolerance is twelve-thousands of an inch. This 
means that any color plate that should be perfectly aligned with the black 
plate may deviate as much as 0.012” from each other.

Please use this information when creating material, paying particular 
attention when using reverse (aka: knock-out) type and fonts created 
with more then one color, as well as fine lines with the same criteria.
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Distiller Setting

http://upload.sandiegouniontribune.com/addrop
http://www.sandiegouniontribune.com/sd-utads-htmlstory.html
www.naa.org
https://www.dropbox.com/s/sd4grgsktqhisy8/PDFX1a%202001%28NoComp%29.joboptions?dl=0


FONT  

TYPE STYLES and USAGE 
TYPEFACES
Sans Serif typefaces are the recommended choice for newspapers. They 
reproduce clearly and are easy to read. The majority of this guide uses a 
Sans Serif as the font, with point sizes ranging from 10 to 24. Typefaces 
with thin or delicate serifs/strokes and non-uniform characters or line 
thickness are not recommended.

For clarity and readability, 10 point or larger type is recommended in 
newspaper advertising design.

Due to the ink/newsprint relationship, small type & fine serifs may lose 
their definition when reproduced on press.

2 and 3-color type not only may lose definition, but registration 
variances may make the type blurry. The San Diego Union-Tribune 
accepts no responsibility for clarity or readability for ads submitted 
with 2 and 3 color type sized 8 points or less. Four-color text is never 
recommended.

If color text is used, font size should be no smaller than 12 points Sans 
Serif and no smaller than 14 points for Serif fonts.

In the examples shown Helvetica (Sans Serif) is used in the left boxes, 
while Times Roman (Serif) is used in the right boxes to provide visuals 
that demonstrate what these types of fonts do when printed.

SURPRINT (OVERPRINT)
For optimum results it is recommended that type not overprint a background 
screened (tint or ghost) greater than 30% of the same color as the type. 
This allows for dot gain and provides necessary contrast between the 
type and background screen.

60% Tint

55% Tint

50% Tint

45% Tint

40% Tint

35% Tint

30% Tint

60% Tint

55% Tint

50% Tint

45% Tint

40% Tint

35% Tint

30% Tint

Helvetica 
(Sans Serif)

Times Roman
(Serif)
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FONT  
Cont...

REVERSE TYPE (KNOCK-OUT)
When using reverse type, be aware that some type styles with delicate 
serifs and fine lines may not reproduce clearly.

Using reverse type of less than six (6) points out of a one color background 
is not recommended for newspaper reproduction.

Type reversed out of color image area should be a minimum of 12 points 
for San Serif fonts and 14 points for Serifs. This will allow for registration 
variances within our tolerance while still producing maximum readability. 

To allow for enough contrast and readability, text should not be reversed 
out of a gray lighter than 40% black nor should it be knocked out of color 
that is less than 70 total area coverage (i.e. 40% magenta & 30% yellow).

SCREENED TEXT
Reproducing text as a screened percentage of a solid color can be 
successfully achieved on newsprint.

It is recommended that screened text be comprised of one or more of 
the ‘text box’ color and not of another color.

For best results, avoid screening type styles with a fine to medium weight 
and those with serifs. As a general rule, text screened to 80% or greater 
will appear as a solid. For legibility reasons, consideration should be given 
when attempting to reproduce type as a light screen tint. Screened 
text should not be less than 24 points. For screened text on a screened 
background of the same color, variance of 50% from one another is highly 
recommended.

12pt Helvetica

10pt Helvetica

9pt Helvetica

8pt Helvetica

7pt Helvetica

6pt Helvetica

12pt Times Roman

10pt Times Roman

9pt Times Roman

8pt Times Roman

7pt Times Roman

6pt Times Roman

60% Screen

55% Screen

50% Screen

45% Screen

40% Screen

35% Screen

30% Screen

60% Screen

55% Screen

50% Screen

45% Screen

40% Screen

35% Screen

30% Screen

Helvetica 
(Sans Serif)

Helvetica 
(Sans Serif)

Times Roman
(Serif)

Times Roman
(Serif)

14pt Times Roman
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These two pages are included to help design process color tints when 
using 4-colors, although when creating tints in a 4-color file the only 
limitation is the 200 Total Ink Limit (TAC). These swatches can also be 
used as a guide for color images.

The large blocks to the top right (Fig. 1 & 2) are in increments of 10%, having 
no black in the mix. The smaller blocks below (Fig. 3) are separated in 20% 
increments, including 20% & 40% black to the process mix. Adding over 
40% black in color type or boxes is not recommended.

To identify the color make-up of the blocks, use the San Diego Union-
Tribune CMYK system (in that order: Cyan Magenta Yellow BlacK).

This system uses numbers to identify the percentage of color in 10% 
increments, and uses ‘A’ to represent 100% coverage; i.e. (Fig. 4) top row 
of small boxes is 4**2, this represents 40% Cyan (4), the following 2 ‘*’ 
represent the corresponding Magenta (left column) & Yellow (bottom row) 
and 20% Black (2). If you were to choose the upper left color swatch of 
that box, the color identifier would be 4A02 (40% Cyan, 100% Magenta, 
0% Yellow, 20% Black).

Missing swatches are those out of the 200 TAC (Total Ink Limit) used 
at the  San Diego Union-Tribune.

COLOR  
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COLOR Cont...
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Click here to 
DOWNLOAD 
the Adobe Swatch  
Exchange file (ase)  

for these  
newsprint swatches

https://www.dropbox.com/s/jh6m1o1145c1sey/NEWPRINT%20SWATCHES.zip?dl=0


REGISTRATION
A critical factor in four-color printing is the proper alignment (registration) 
of the four printing plates on press. Proper alignment will result in clean, 
sharp images and colored text. Improperly aligned plates will create fuzzy, 
out-of-focus color images and text.

There are built-in variances that cannot be corrected by the pressroom 
100% of the time. For this reason, SNAP & the San Diego Union-Tribune 
have an out-of-register tolerance of 0.012”.

Alignment of any color to black within the tolerance of 0.012” will be 
deemed as acceptable registration.

PRINTING COLORS
The San Diego Union-Tribune uses NAA Volume 10 process inks that 
are specially formulated for newspaper reproduction as listed in the 
Newspaper Association of America (NAA; www.naa.org), Volume 10, 
Ad-Litho Inks book. PMS or Pantone colors and/or document colorspace 
are not supported. If used, PMS colors will be converted to the appropriate 
CMYK percentage breakdown and printed with Ad-Litho inks.

The results may be acceptable. However, the colors will be different than 
the examples in the Pantone swatch book.

Refer to the Process Color Matching Guide or download the Newsprint 
Adobe Swatch exchange file on page 7.

CREATING BLACK USING FOUR COLORS
Using four colors to produce a ‘rich’ black is unacceptable. Inking shifts can 
create unwanted hues and mis-registration of type becomes much more 
visible. Also, Total Area Coverage (TAC) for images/continuous tone will to 
be brought down to 200.

The San Diego Union-Tribune recommends using 20% cyan behind black 
to boost the intensity of the black. If a 4 color rich black is key to the design 
(body text excluded), create it in an image format, not path or vector to 
avoid the preflight process stripping out the under color.

Special care should be taken when importing text from one 
program to another. Black/grayscale text that is imported 
into a four-color program/layout has a tendency to convert 
to four-color text. Please verify that text has remained black-
only when importing a file from one program to another.

TOTAL AREA COVERAGE (TAC)  
or TOTAL INK LIMIT (TIL)
Newspaper printing is a ‘non-heatset’ offset process. It requires a 
maximum scanning density (TAC/TIL) of 200%. This means that when 
the percentages of Cyan, Magenta, Yellow & Black in the shadow areas are 
added the sum is at 200 or less. When the TAC/TIL is too high, it causes 
increased ink set-off (a transfer of ink to a facing page) and image show-
through (image visible through the other side of the page).

COLOR IMAGE REPRODUCTION
The San Diego Union-Tribune requires color imagery to be converted to 
CMYK using profiles specific for newsprint before placement within an 
ad layout, Working Space Profiles recommended for color conversion 
are ColorMatch RGB for the RGB color space and ISOnewsprint26v4 
(recommended) for the CMYK color space. Rendering Intent should be 
set at Perceptual. 

Max black in the shadows should fall between 88% and 95%, to avoid 
imagery looking “flat”, the closer to 95%, the better. Grays should NOT 
be created by equal amounts of CMY over K or with no K. Grays should be 
created with equal amounts of CMYK under K or using the black channel 
only. 

We do not support color conversion on output driven by embedded profiles.

Please see RGB to CMYK image conversion on page 11

PRINTING 4C/BW 
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IMAGE SHARPENING
The use of Unsharp Masking (USM) is strongly recommended. Settings for 
the ‘Amount’ and ‘Radius’ will vary depending on the size/pixel amount, 
and resolution of the image being sharpened.

RESOLUTION: 
PHYSICAL VS. EFFECTIVE ON IMAGES
Physical resolution is the resolution of the native file. Effective resolution is 
the resolution of that file once it is enlarged or reduced in a layout program.

The San Diego Union-Tribune expects final files to be delivered at an 
effective resolution of 200-300 PPI (170-200 acceptable). A higher resolution 
only increases file size and will not improve look of the printed material. 
Conversely, a resolution lower than 170 will effect the look of images. The 
lower the resolution, the more ‘pixelated’ the image will look.

For example, if an image has a physical resolution of 200 PPI (in Photoshop), 
but is enlarged 200% in the layout program, the image will now have an 
effective resolution of 100 PPI and the quality will suffer. That same image 
reduced 50% in a page layout program will have a resolution of 400 PPI 
and create a file larger than needed.

GRAY BAR FOR COLOR PAGES
For improved density control and color consistency the San Diego Union-
Tribune’ page templates typically place a ‘gray’ bar at the bottom of color 
standard pages or in the fold for color tabloid pages.

The bar measures 3/32" and runs the width of the page on standard pages 
or the depth on tabloid pages.

Although called a “gray” bar, the bar is in fact a mixture of Cyan, Magenta 
and Yellow to create a neutral gray. No black is used within the gray area 
of the bar.

BLACK & WHITE
The majority of color specification for color reproduction also applies to 
black & white files.

Special care needs to be taken when converting color Images to grayscale.

Because the colorspace Is reduced from millions of colors to 256 shades 
of gray, different colors may ‘blend’ into the same shades of gray. For 
example, a dark red and a dark blue may look different in color, but will 
look very similar in grayscale.

With dot-gain, the two colors may be indistinguishable as shades of gray.

Depending on the tonal range of the image converting to Grayscale 
from CMYK, it may be beneficial to convert it back to RGB first with the 
Rendering Intent set to Relative Colormetric, adjust if necessary, and then 
convert to Grayscale with the Render Intent to either Relative Colormetric 
or Perceptual, which ever gives you the best results.

Profiles to use for converting to grayscale can be either ISOnewsprint26v4_gr 
or the Photoshop Dot Gain30%.

SPOT COLOR
Spot Color plating is not supported In the current process used by the SDUT.

Any Spot color ads submitted are converted into its respective NAA 
breakdown of CMYK.

PRINTING 4C/BW 
Cont...
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25% 37-42%

50% 76-80%

75% 87-92%

7% 0%

(INPUT) (OUTPUT)

THREE QUARTER-TONES

MID-TONES

QUARTER-TONES

PERCENTAGES BELOW 7%

ORIGINAL NEWSPRINT

+12% to +17%

Dot Gain

+26% to +30%

Dot Gain

+12% to +17%

Dot Gain

-7% to -0%

Dot Loss

DOT GAIN - DOT LOSS -  MONITOR PROFILES
DOT GAIN
The San Diego Union-Tribune is in line with the industry standard (SNAP) 
regarding dot gain for Offset printing using a 100lpi, CtP workflow.

At 50% (Mid-Tone) there is a  
26-30% tone value increase (TVI), 
or Dot Gain, +/-4%.

The increase is in a bell-curve shape 
- not linear.

The Quarter-Tones (25%) gaining 
12-17% and Three Quarter-Tones 
(75%) gaining 12-17%.

The important items to remember are:

1. Images will generally print darker than what you see on the monitor.

2. B/W gain will be limited to Black, while process color images 
gain on all 4-colors (4x the gain).

3. Shadow detail will generally be lost.

DOT LOSS
Due in part to the plate-to-blanket-to-paper process on press, dot 
percentages below 7% cannot be guaranteed to print.

With gradations (vignettes) a hard edge from 7% to 0% may occur. 
Highlight dots used to create subtle contrast may create a break. This is 
prevalent with skin tones and clouds using tints that drops below 7% in 
the highlight areas.

PRINTING 4C/BW 
Cont...
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Note: The CMYK make-up of any individual 
color will be affected by dot gain / loss. 

e.g. A background image with a light pastel 
green containing a mix of 4% Cyan and 
10% yellow, may appear yellow(er) when 
printed. The total ink coverage for the 
Cyan and Yellow is 14%, however each ink 
is printed individually and it’s make-up must 
be within tolerance. The Cyan being under 
the 7% threshold for dot loss, will be likely 
lost on press. 

Input Output

On a microscopic level, dot 
gain would look like this:

Dot Gain on Press

Quarter Tones 

Three Quarter Tones 

Mid Tones +12-17%

+26-30%

+12-17%



COLOR PROFILE DOWNLOAD
Use the ISOnewspaper26v4.icc profile in Photoshop to convert RGB images 
to Newsprint CMYK

Click the icon to the left to download the 
ISOnewspaper26v4.icc profile 

How to install the ICC profiles: https://helpx.adobe.
com/photoshop/using/working-with-color-profiles.html

Once installed, follow the instructions below; this process is for flat 
(jpg, tif) or layered Photoshop documents

CONVERTING RGB IMAGES TO NEWSPRINT CMYK
1. Start by opening the original RGB image in Photoshop

2. From the Photoshop menu bar 
    select Edit > Convert to Profile...

3. Using the Profile: pull-down menu select “ISOnewspaper26v4”

Make sure “Flatten Image to Preserve Appearance” is checked OFF, 
otherwise this will flatten the any layered psd file. After you’ve made sure 
it’s off hit “OK”. Select “Use Black Point Compensation” and “Use Dither”.

You may also be prompted with “Changing the document profile can 
affect the appearance of smart objects. Rasterize smart objects before 
changing profile?” Select Don’t Rasterize

RGB image

RGB to CMYK 

DOWNLOAD ICC
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Relative Colorimetric or 
Perceptual depending on the 
subject matter. Perceptual 
being the preferred.

ISOnewspaper26v4.icc
ISOnewspaper26v4.icc
https://helpx.adobe.com/photoshop/using/working-with-color-profiles.html
https://helpx.adobe.com/photoshop/using/working-with-color-profiles.html
https://www.dropbox.com/s/qfrwv3cgc8d95kt/ISOnewspaper26v4.icc?dl=0


4 .After converting your image to CMYK, sharpen the image by applying  
Unsharp mask (Filter > Sharpen > Unsharp mask). Enter the values under 
Amount, Radius and Threshold as shown on the preview below. (This can 
be use as a default starting point for UnSharp Masking settings for newsprint)

Settings for the ‘Amount’ and ‘Radius’ will vary depending on the size/
pixel amount, and resolution of the image being sharpened.

Be sure you are viewing your image at 100% (the range can be as low as 
1.0 and as high as 3.0 depending on how it views on screen).

If a ‘halo’ is detected separating highlights and shadows, boost the 
‘Threshold’ level past 0 or reduce the ‘Amount’ factor.

Once you have the desired adjustment, Click “OK”

Now that the image has been converted to CMYK using the proper setups 
and profiles for the newsprint gamut, you’ll have to assess if the image 
will need any more adjustments to achieve pleasing reproduction in print.

Printing on Newsprint and the conversion method of images to the 
newsprint gamut can make images look flat and unappealing.

Below are three curves specific for newsprint reproduction that add 
contrast, depth and gain compensation to varying degrees.

It mainly depends on the depth of density and the quality of the RGB as 
well as the tonal range of the image that will determine which curve should 
be applied to garner the best reproduction value.

For someone with more experience, to fine tune an image using multiple 
incremental steps, the Photoshop Actions supplied (pg 14) is another option.

RGB to CMYK 
Cont...
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130%

1.0

10

ISO Conversion ISO Conversion with (Min) Curve 

Before moving forward download and 
install the 3 preset adjustment curves. 

PSD CURVES

https://www.dropbox.com/s/589x3e68bp4wygx/LAT%20CURVES.zip?dl=0


RGB to CMYK 
Cont...
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5. Next, use the Photoshop Info Panel (Window > Info) to determine 
your color make-up/tones. Click the eyedropper icon in the top left 
of each quadrant, change the 1st to Total Ink (TAC) and the second to 
CMYK color (See fig 1). 

6. Now hover your cursor over the light, mid and darker areas to 
determine the tonal ranges (See fig 2). These will help you determine 
which curve is best suited, based on the expected dot gain.

On the presets, each point found on the curve(s) is pulled back/compensating 
for dot gain on press. The (Max) being the most aggressive and accounting 
for full compensation in each tonal range. The others follow suit but aren’t 
as harsh.  

7. To apply the curves open the curves adjustment panel (Image > 
Adjustments > Curves)

From the Curves preset drop down menu you’ll find the 3 Newsprint 
curves you previously downloaded and installed: Newsprint Dot Gain: 
(Max), (Mid), and (Min).

Fig. 1

Newsprint Dot Gain (Max)

Quarter Tones Three Quarter Tones
Mid Tones

25% 37-42%

50% 76-80%

75% 87-92%

7% 0%

(INPUT) (OUTPUT)

THREE QUARTER-TONES

MID-TONES

QUARTER-TONES

PERCENTAGES BELOW 7%

ORIGINAL NEWSPRINT

+12% to +17%

Dot Gain

+26% to +30%

Dot Gain

+12% to +17%

Dot Gain

-7% to -0%

Dot Loss

Fig. 2



RGB to CMYK 
Cont...

page 14

Your curve selection will be determined on the make-up of you original 
image. Select the best option in conjunction with the readings from the 
info panel. 

You can also modify these presets to best suit the needs of each image, 
and use them with the preset actions below.

To adjust, individually move the 3 points along the path (preferably straight 
up and down). The closer a point is to the Baseline (45o line) the less 
compensation. The further away the more compensation. Keep in mind 
the amount each tonal range gains on press, avoiding over compensation. 
Once you found the curve best suited and/or adjusted, click OK. 

8. Go back and take a final reading of the numbers using the info panel. 
The Max black (K) in the shadows should fall between 88% and 95%, to 
avoid  imagery looking “flat”, the closer to 95%, the better.

Any additional adjustments can be made using adjustment 
layers or you can download the recommended Photoshop 
Actions to the left. Done.

ISO COMPARISON
Below are two images with the ISOnewspaper26v4.icc profile applied, 
the one on the left just has the ISO profile. This looks better on screen 
and when printed on white paper. It appears to be the safer bet, however 
the image on the right will reproduce better when printed, this image is 
compensating for the substrate (newsprint).   

Converted to ISO profile Converted to ISO profile with (Min) Curve applied

PSD ACTIONS

PRO TIP: Rely on the readings from the info panel even though the images 
may look a bit washed out. Your Photoshop proof settings, monitor, 
ambient lighting etc. all play a role on how the images appear on screen. 
The numbers don’t lie.

Newsprint Dot Gain (Max) Newsprint Dot Gain (Mid) Newsprint Dot Gain (Min)

Most aggressive dot gain 
compensation. Avoid going 
over these amounts/Over 
compensating. Also best for 
images that are already CMYK  
& are prepped for magazine 
gamut/SWOP.

Least aggressive dot gain 
compensation. Gives you more 
freedom to adjust manually. 

Middle of the road dot gain 
compensation. 

ISOnewspaper26v4.icc
https://www.dropbox.com/s/dxk8edtdyxamr0b/PHOTOSHOP%20ACTIONS.zip?dl=0


CHECKING THE INK LIMIT  
IN ADOBE INDESIGN
How to check the ink limit with a InDesign document, this will highlight 
swatches and images (Vector and Raster) that are out of spec. 

Open your InDesign file, from the document menu bar select 
Window > Output > Separations Preview. 

In the “View:” drop-down menu within the Separations 
panel, choose Ink Limit and enter 200% as the maximum 
Ink Limit percentage.

InDesign will change your preview document to gray, 
and highlight all areas that exceed the chosen ink limit 
(200%). See example on the bottom left (fig 1.) 

If little or no areas are highlighted your document is 
within spec. Otherwise you’ll need to adjust the CMYK 
values (Images or swatches) to be within tolerance.

To revert back to normal view change the View setting 
in the Separations Preview to: off

Before and After comparison, the red highlights indicate TAC over 200

RGB to CMYK 
Cont...

Change to 200%

Original un-edited RGB image

Original un-edited RGB image

Converted image with (Min) Curve

Converted image with (Min) CurveFig. 1
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FORMAT
• All completed ads should be submitted in PDF/X-1a:2001 format

• Do not include bleed or trim marks, PDF should be built to finished size.

TOTAL INK DENSITY 
• 200% TAC /TIL

IMAGE RESOLUTION
• 200 DPI or higher

• Image sharpening is recommended 

COLOR
• CMYK converted using ISOnewspaper26v4.icc profile. No RGB, DCS, 

Spot, LAB or Duotone color spaces.

• Max black in the shadows should fall between 88% and 95%, to avoid  
imagery looking “flat”, the closer to 95%, the better.

BLACK AND WHITE
• Converted using Photoshop Dot Gain 30% profile

LINE SCREEN
• Output 100 LPI 

TYPE
• For clarity and readability, 10 point or larger type is recommended

• Type reversed out of color image area should be a minimum of 12 points 
for San Serif fonts and 14 points for Serifs

• Screened text should not be less than 24 points

• Black text should be 100% K  

DOT GAIN
• At 50% (Mid-Tone) there is a 26-30% tone value increase

• Quarter-Tones (25%) gaining 12-17% tone value increase

• Three Quarter-Tones (75%) gaining 12-17% tone value increase

DOT LOSS
• Dot percentages below 7% cannot be guaranteed to print. With gradations 

(vignettes) a hard edge from 7% to 0% may occur. 

RESOURCES

SPECIFICATIONS
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PSD Curves

Photoshop 
Curves

PSD ACTIONS

Photoshop 
Actions

Distiller Setting

Distiller PDF 
Setting

ICC  
Profile

DOWNLOAD ICC

https://www.dropbox.com/s/589x3e68bp4wygx/LAT%20CURVES.zip?dl=0
https://www.dropbox.com/s/dxk8edtdyxamr0b/PHOTOSHOP%20ACTIONS.zip?dl=0
https://www.dropbox.com/s/sd4grgsktqhisy8/PDFX1a%202001%28NoComp%29.joboptions?dl=0
https://www.dropbox.com/s/qfrwv3cgc8d95kt/ISOnewspaper26v4.icc?dl=0


CONTACTS
For file or image prep questions please reach out to:

email: SDAdvertisingCreative@sduniontribune.com

Alex Munro Rankin: 619-293-1597

Dave Novotney: 213-237-6986

mailto:SDAdvertisingCreative%40sduniontribune.com?subject=

